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Note: Customer is responsible for FEDEX shipping and all local Customs, Tariff, VAT, Taxes and incidental 
charges within their delivery [address] Country. Please contact Apache Support <support@apach-labs.com> for 
details regarding your order or shipping charges.

Apache Labs LLC, Inc. - Declarations of Conformity

The ANAN-8000DLE complies with FCC Part 97 rules for the Amateur Radio Service. It has been confirmed by 
the relevant authorities that the ANAN-8000DLE DOES NOT require FCC certification of any sort. Under rule 97 
Amateur radio equipment with the exception of amplifiers and scanning receivers are exempt from certification, 
however, must conform to rule 97 which states that harmonic and spurious emissions must be below 43dB of 
the transmitted out up to 30MHz and 60dB beyond that.

Apache Labs Products CE and RTTE Certified

CE & EC Radio and telecommunications terminal equipment [RTTE] Certification.
We are pleased to announce that the ANAN series HF & 6M SDR transceivers including the ANAN-8000DLE is 
now CE and RTTE certified as per EU trade directives,  All ANAN radios are RoHS compliant as well, we ensure 
that our products are of the highest quality and meet international standards of quality and 
compliance.Important Operation tips

Do not cover rear or bottom fan and ventilation holes. Proper air circulation throughout the ANAN 
Transceiver is necessary to prevent possible overheating and failure.

Calibrate power output to from 1W to 200W using a suitable 50 ohm Dummy Load. Operating at higher 
levels will damage the radio.  Please review CCW and ICAS specifications on this page.

Data/AM/FM and other continuous duty modes must be operated at 60W or less to remain within the 
operational limits of the ANAN

Input voltage must be 13.8vdc +/- 5%, well regulated at 40A and proper POLARITY must be 
observed.

DISCONNECT the Antenna during Thunderstorms or when not in use.

Please ensure that you select the correct model during software setup.

Heat Dissipation

Apache has stated that “The ANAN-8000DLE includes a heavy duty Aluminum plate to dissipate heat. The plate 
generously runs the entire width of the chassis.

Ventilation holes in the bottom of the ANAN-8000DLE must be clear of obstructions so that the 
internal fan can pull hot air from inside the unit. 

The ANAN-8000DLE should not be operated at greater than 30% of it's rated power when used for extended 
duty cycles such as digital, AM, and FM operation. 

Clarification CCS [60W]/ICAS [200W] operation

RTTY/AM/FM, CCS [Continuous Commercial Service] 60W

SSB, CW and all ICAS modes [Intermittent Commercial/Amateur Service] 200W PEP

The Power Amplifier LDMOS transistor has characteristics that far exceed the needs of normal Transceiver 
operation. They are quite rugged. However, other internal components such as the Toroids, Filters, Integrated 
Circuits, and some small SMT parts must also be considered when high duty cycle modes are in use. There are 
three voltage rails all of which have thermal shutdown protection built in.  
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1.  ANAN-8000DLE Architecture
We are very proud of the 8000DLE Design Team

Phil Harman, VK6PH

Doug Wigley, W5WC

Dr. Warren C. Pratt,  NR0V

Kjell Karlsen, LA2NI

Abhishek Prakash

Dr. Joe Martin, K5SO

John Melton, GØORX/N6LYT

Adam Farson Ab4OJ/VA7OJ

General Specifications:

Architecture: Direct Sampling DDC/DUC Transceiver

Interface: Ethernet

Phase Noise (clock): -149dBc @ 10Khz

TCXO Stability (Typical): +/- .1ppm

Modes: CW, SSB, NFM, AM, Digital

Antenna ports: Three SO-239 50 ohm Software Configurable Ports, one BNC dedicated for Rx2

Frequency Resolution: 1Hz

Electrical Specifications:

13.8vdc @ 40A, Internal DC to DC 50vdc Boost supply for the LDMOS Power Amplifier, 

3A Rx, 40A Peak Tx

Mechanical Specifications:

12Kg/27lb (approximate weight)

Dimensions 483mm(L) x 123mm(H), 320mm(d) not including various port extensions

Stainless Steel Chassis and massive Aluminum Heatsink

Receiver Specifications:

Receiver Architecture: Direct Down Conversion

Dual 16bit Phase Synchronous Analog to Digital Converters

Independent filter banks for each ADC

6M Low noise amplifiers

Frequency Coverage: 0Khz to 61.44Mhz

Attenuator: software controlled 1-31dB step attenuator

Reciprocal Mixing Dynamic Range (RMDR): 116dB @ 2Khz

Image Rejection: 100dB

Hardware Support for 7 independent receivers assignable to either ADC
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Transmitter Specifications:

Transmitter Architecture: Direct Up Conversion

Digital to Analog Conversion Resolution: 16bit

RF Output Power: 1-200W SSB, CW, ICAS modes.     1-50W FM, AM, Digital, CCS modes.

IMD: IMD3 typically -72dB @ 200W output on 20M

Harmonics: Typically better than -50dBc on HF and -60dBc on 6M

Carrier and Opposite Sideband Suppression: Better than -80dBc (PowerSDR mRx PS v3.3.10)

Audio Connections:

The ANAN-8000DLE has RCA line input for the Left and Right audio channels (RLINEIN and LLINEIIN). 
The line-input gain is arithmetically adjustable (Log) from 12dB to -34.5dB in 1.5dB steps.  The 
maximum input level is 1.0v RMS.

The Radio has two Barrel audio connectors for MIC IN, one on the front panel (6.25mm Barrel Audio) 
and the other in the rear panel (3.5mm Audio).  MICIN is a high-impedance, low capacitance input that 
is compatible with a wide range of popular microphones. 

A stereo connector is required for the MIC IN where the PTT, MIC Bias, Ring, and sleeve  are software 
assignable in PowerSDR.

The Radio has two RCA low-impedance line output (LLINEOUT and RLINEOUT) capable of driving line 
loads with 10k-ohm and 50-pf impedance. 

The Radio has stereo headphone output, one on the front panel (6.25mm barrel audio) and the other 
on the rear panel (3.55mm audio) and is designed to drive 16-ohm or 32-ohm headphones.  1/4” to 
1/8” adapters are included in the standard 8000DLE shipping package. 

Additional I/O Connections:

RCA PTT INPUT and OUTPUT (25v, 2000mA max)

Seven Open Collector outputs are available on a DB9 connector with each output rated at 20v, 200mA 
max.

L and R speaker outputs on 6.25mm audio barrel connectors, 2W output at 8-ohm impedance. 

13.8vdc, 40A Industry Standard PowerPole DC connector on the rear panel

Gigabit capable RJ45 Ethernet LAN connector

Bootloader Slide switch is easily accessible and prominent on the back panel to enable or disable 
bootloader functions

A robust grounding lug

Ethernet Command and Control:

The ANAN Transceivers use a Gigabit Ethernet interface to connect to your LAN. Ethernet command and control 
features huge bandwidth, better noise isolation from the PC, and networked radios with remote access. Beta 
testers report good performance across 802.11n WiFi links. 

Noise Blankers:

The ANAN-8000DLE provides a choice of two Wideband Noise Blankers in addition to the new Spectral Noise 
Blanker by Warren NR0V.

The two Wideband Noise Blankers are:
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A preemptive Blanker which effectively slews it’s output to zero before an impulse arrives, and then 
slews back to full amplitude after the impulse passes.

An Interpolating Noise Blanker which is also preemptive, but has modes such as Linear interpolation of 
the signal during the impulse.  Wideband Noise Blankers, while they are the best choice in some 
situations, have a well-known issue that they may become ineffective in the presence of strong adjacent
signals, for example during a busy contest.  The Spectral Noise Blanker cleverly overcomes this 
deficiency by using Linear Predictive Coding (LPC).  LPC provides the capability to predict a sequence of 
samples by analyzing the spectral content of the samples before and after the sequence. By comparing 
the predictions with the measured samples, impulses are detected and blanked or reduced. The LPC is 
again used to predict what the signal waveform should be during the incident pulse and thereby replace
the corrupt samples with clean signals.

Noise Reduction:

Two types of Noise Reduction algorithms are provided to minimize random noise.  

The first is a special implementation of a Least Mean Square (LMS) algorithm and the second is a new Spectral 
Noise Reduction NR2 (2015).  LMS algorithms are used in most Software Defined Radio’s and Digital Signal 
Processing modules due to their relatively simple implementation and low compute requirements.  However they
use only the input signal as a reference to identify the output and therefore are unable to achieve optimal 
signal-to-noise ratios and they sometimes yield an unusual “in the barrel” or “underwater” sound.  The new 
Spectral Noise Blanker specifically uses sophisticated statistical models of speech and noise to produce superior 
signal-to-noise ratios and vibrant sound output.

Minimized Latency:

In Software Defined Radio’s, filtering usually contributes the most  latency. There are two reasons; (1) large 
sets of samples, “buffers”, are normally collected before executing the filters so that efficient FFT algorithms can
be used, and (2) sharp “brick-wall” linear-phase filters inherently have long latency, no matter how cleverly they
are implemented.   Both these issues have been addressed and conquered in the ANAN-8000DLE Transceiver.  
Small “buffers”, requiring little collection time, can now be used even while retaining the very sharp “brick-wall” 
filters.  In addition, the option of using very low-latency “minimum-phase” filters is provided.  In almost all 
situations, laboratory and on-air testing have demonstrated no discernible difference in performance between 
linear-phase and minimum-phase filters.  With filters as sharp as you desire, sub-20ms receive latencies are now
possible, compared to the best of conventional DSP radio’s and must better than competing Software Defined 
Radio’s.

Two phase synchronous ADCs

ANAN-8000DLE includes two phase synchronous front ADC’s to enable Diversity reception and other advanced 
applications. The Transmit chain is designed keeping in mind the unique “PureSignal” Linearization and pre-
distortion.

Front Panel LCD display

The front panel Display uses a dedicated microprocessor. Various parameters such as Forward and Reflected 
Power, SWR, Current, Voltage, Temperature are clearly displayed for ease of visual reference. The 
microprocessor also provides real time protection for all these variables.  The firmware program for the 
microprocessor can be easily updated using a standard micro-USB cable and Android IDE software. This 
procedure is explained in the Appendix of this document. 
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PureSignal Pre-Distortion:

There is no truly Linear RF amplifier. The Non-linearity in an amplifier shows up as Intermodulation Distortion 
(IMD) Wikipedia reference: https://en.wikipedia.org/wiki/Intermodulation within and outside the transmitted 
bandwidth. There are many challenges to reduce IMD, hence, most manufacturers of Amateur Radio Equipment 
do not specify their IMD, or use inefficient Class-A options that lower IMD at the expense of power.  The ANAN-
8000DLE was designed with the unique PureSignal Linearization (Pre-Distortion) to achieve an astounding 
-72dBm IMD on 20M at full 200W output.  This achievement in design is an improvement of at least 25 to 30dB 
or approximately 1000 times lower distortion than conventional “Class-C” capable flagship transceivers. 

Ultra-Rugged LDMOS 50vdc

The ultra-rugged 50vdc LDMOS power amplifier module is capable of handling extremely high SWR. It provides 
inherent ruggedness and all the benefits of low,  state-of-the-art,  LDMOS IMD figures when used with the 
unique PureSignal.
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2.  Introduction
Introduction

The ANAN-8000DLE Amateur Radio Transceiver is a modern direct-down-conversion [DDC] receiver, and direct-
up-conversion [DUC] transmitter, Software Defined HF transceiver plus 6 Meters. The ANAN-8000DLE has a 
proud heritage from the TAPR Hermes Transceiver introduced in 2012. The ANAN-8000DLE was cooperatively 
designed by the OpenHPSDR Team and Apache Labs. Please see “Contributing Members”.

The Apache Labs ANAN equipment includes the “Hermes”, “Angelia”, and “Orion” designs in a series of new 
transceivers. The ANAN-8000DLE is operated on a 100Mbps Ethernet interface to the host PC. The ANAN does 
not use a Firewire™, or USB interface.

ANAN firmware updates can be easily installed via the Transceiver standard Ethernet connection, eliminating the
need for special mechanical or programming adapters.  It is not necessary to open the 8000DLE cabinet to 
update the firmware. A “Bootloader” switch has been added to the rear panel of the 8000DLE for ease of future 
updates. 

ANAN Transceivers can be used with a number of different PC Software Defined Radio programs including those
written for Windows®, Linux, MacOS/X®, Android, RaspberryPi, and other operating systems.   The most popular
at this time is “PowerSDR mRX PS” (PowerSDR enhanced with multiple receivers and PureSignal Linearization) 
and the pihpsdr-Controller designed by John Melton G0ORX. 

Note: Please see the Apache Labs ANAN Transceivers webpage: https://apache-labs.com/index.php
OpenHPSDR software webpage: http://openhpsdr.org/download.php

Minimum Requirements 

Computer basic requirements

 Intel i3, 2.8Ghz or better [recommended].

 4GB Ram or more [recommended].

 1280x1024 display screen [or higher] resolution recommended

 Windows 7 or newer. It is possible that some older machines or minimally configured “Netbook” 
computers may not give satisfactory performance, regardless of processor speed.

 Computer with Full Duplex Ethernet NIC card capable of 1000 BaseT/Gigabit Ethernet is recommended,
however the transceiver and Thetis control software currently operate at 100BT.

 Full Duplex Ethernet switch or router with 1000Mbs Ethernet port recommended.

 CAT5 or CAT6 [recommended] Ethernet patch cable to connect ANAN to Ethernet switch, router, or 
computer.

Older and slower Desktop, Laptop, Tablets, or Notebook computers may require considerable optimization 
before they can provide necessary performance for trouble free SDR operation. This optimization may require 
that certain applications and services be stopped in order for the Apache Software to operate correctly. It is 
possible some older or slower machines will not give satisfactory performance, regardless of processor speed.
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Suitable routers or LAN Network switches

A Full Duplex wired or wireless Ethernet with sufficient ports to connect the host computer and the ANAN at 100
BaseT. An optional Full Duplex Ethernet switch with 1000 BaseT Internet connectivity may be required if 
additional Ethernet ports are needed. Ethernet HUBS   will   NOT   work   properly for this software application.  

Ethernet Connection

ANAN should be connected directly to a dedicated Ethernet port on the host PC or to a port on a suitable 
Ethernet router or switch. Connection to a dedicated Ethernet port is shown above.

For direct connection of ANAN to a dedicated Ethernet port, a CAT 6a Ethernet cable is used. Note that a 
‘crossover’ cable is not necessary.

Note: The Ethernet switch should be capable of operating in full duplex mode at 1000 BaseT[Gigabit]. 
A 100 BaseT Ethernet switch may be used in the interim, but if a new purchase is planned then a 1000 BaseT 
[Gigabit] switch is recommended.

An Ethernet “HUB” will not work properly and is not recommended.
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Simple network setup

The OpenHPSDR ANAN Transceivers are designed to work via Ethernet cabling on [a] "Local Area Network" or 
[b] directly connected to your Windows PC. Ethernet simplifies the installation, and configuration of hardware 
and software, making the installation basically “plug and play”. No sound card interface wiring, no Firewire® 
cards or drivers, no USB ports or drivers are needed. It just works!

For the most basic network, you don't need any external hardware other than an Ethernet cable 
between your Windows PC LAN port and your Transceiver's LAN port.

The ANAN Transceivers are setup to ask for a “DHCP” network address or an APIPA address 
[discussed in Appendix below]

Hardware Requirements
13.8vdc minimum, 40A [Recommended]
Note: some switching DC supplies create objectionable EMI/RFI which may degrade performance of the 
ANAN transceiver.

 Ham band resonant 50 ohm HF antenna for normal Ham Radio operation.

Suitable 200W Dummy Load required for PA calibration.

 PC condenser microphone terminated in 3.5mm - 1/8” plug, for SSB phone operation.

 CW key terminated in 3.5mm - 1/8” Stereo plug, for CW operation.

A set of stereo speakers or stereo headphones with a 3.5mm - 1/8" stereo plug.

Note: the Front Panel connections to the 8000DLE are 1/4” jacks. The rear panel connections for MIC, 
Headphones/Speaker, and Key are 1/8” jacks.

Recommended Software

 Windows  7, 8, or 10 recommended.

 Microsoft .NET 4.0+ Framework or later required.

 OpenHPSDR PowerSDR

OpenHPSDR Software   and download information   http://openhpsdr.org/download.php.

Windows  7, 8, 10 PowerSDR™, Thetis, KISS Konsole, 
ghpsdr3

Linux cudaSDR, cuSDR, ghpsdr3, GnuRadio

Android “OpenHPSDR” by John Melton 
GØORX/N6LYT

Java “openhpsdrJ”  by John Melton 
GØORX/N6LYT

PiHPSDR-Controller 
(RaspberryPi)

“pihpsdr” by John Melton GØORX/N6LYT

MAC
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1  -  RESET switch initiates Self Test 
sequence

2  -  STANDBY switch disables the PA and 
places the rig in Rx mode.

4  -  Headphones 1/4” stereo jack

5  -  MIC microphone 1/4” stereo jack

6  -  CW Key 1/4” stereo jack

7  -  POWER switch

1 2 4 53 6

7

ANAN-8000DLE Front Panel
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LCD Front Panel display Power and Self Test

Self Test when power applied to the Transceiver

Self Test complete and all tested circuits working properly

Operational LCD Display when ready for Rx and Tx

LCD microcomputer sensors

A0 Forward voltage
directional coupler

Dir coupler FWD

A1 Reflected voltage
directional coupler

Dir coupler REFL

A2 NTC 10k- Temp NTC (10k to +5v)

A3 50v supply - voltage ACS713 Voltage

A4 50v supply - current ACS713 Current 

A7 TX/RX_STATUS PTT - read status
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ANAN-8000DLE Back Panel
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 1      RJ-45 LAN, 3.5mm Key, Headphones, MIC          XVTR Tx Output

         
 2      Bootloader switch enables FPGA 
         Firmware “Bootloader” mode default OFF            RF1 reserved
                                                
 3    10Mhz Clock input   
        external precision clock input           

          Station Ground Terminal
 4     LLine IN, Rline IN, LlineOUT, Rline OUT
        PTT IN, PTT OUT

 5     Right and Left Balanced Audio Speaker           Anderson PowerPole®

                  13.8vdc @ 40A
           
           9 Open Collector OUTPUT

      

     

3

5

8

421

6

7

6 7

8

9

9

1
0



ANAN-8000DLE back panel  Antennas

The Antenna selections in the 8000DLE controlled by the software in the Setup → General → ANT Filters
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ANAN-8000DLE back panel LAN/Phones/Mic/Key

Mic Jack assignment controlled by Setup Menu
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Local Area 
Network

CW 
Key

Stereo 
Headphones

Condenser 
Microphone



ANAN-8000DLE back panel XVTR RF1

PureSignal connectors                  Ground 

(usually looped together at factory)  connection
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3.  PowerSDR MRX PS  Instructions
please refer to front and back panel illustrations

Hardware Setup

The ANAN transceiver should be carefully placed to allow unobstructed airflow around and beneath the 
housing. Damage can occur if the ventilation openings on the bottom or chassis of the ANAN 
Transceiver are blocked. Allow room for airflow between the housing and other equipment.

Connect the supplied 13.8VDC cable to the rear panel power connector and to a filtered 13.8VDC +/- 
5%, power supply capable of providing up to 40A. observe proper polarity

Connect a suitable ground cable to the rear panel ground terminal to your station RF ground, in 
accordance with good amateur practices.

Connect a 50 ohm transmission line between the rear panel ANT1 SO-239 connection and a 50 ohm 
dummy load.

Connect powered stereo speakers or a stereo headset to the front or rear panel 1/8" (3.5mm) stereo 
jack.

For Phone operation connect a condenser PC microphone equipped with a 1/8"(3.5mm) plug into the 
front panel mic jack.  Note that the wiring of this jack is software controlled in the Setup menu of 
PowerSDR.

For CW operation, connect your favorite paddles to the CW KEY jack on the front panel.

Connect a CAT 5 Ethernet cable between the back panel RJ45 LAN jack and your router, Gigabit switch, 
or PC Ethernet port.  Note: the Automatic Private IP (IP) Assignment (APIPA) feature in incorporated in 
the firmware of the ANAN-8000DLE so that no cross-over cable is needed.

When 13.8vdc power is applied, the LCD panel will begin a Test of various circuits and report any out of bounds 
values.   The RESET switch will cause the internal microprocessor to repeat the Self Test process. 

The purpose of the STANDBY switch is to disable the PA so that the 8000DLE will remain in Receiver mode.
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Software Setup 

Go to the OpenHPSDR   Software Download    page   and select the OpenHPSDR/PowerSDR_mRX_PS Installer 
software for Windows: http://openhpsdr.org/download.php 
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Download the stable release version
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Windows Installation

The Appendix of this document explains how to install multiple independent versions of PowerSDR.

Execute [RUN] to start the Installer at this time.

Note: You may be asked to install the full Microsoft .NET 4.x Framework  if the Installer determines that your PC
does not have the necessary .NET version installed.  You may manually install the Microsoft .NET 4.0 Framework
from Microsoft .NET software

Once you have Microsoft .NET 4.0 installed successfully, you can run the OpenHPSDR/PowerSDR installer to 
complete this process. See the example above:
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Wisdom optimization calculation

Click on the desktop ICON to start OpenHPSDR/PowerSDR mRX PS. If a OpenHPSDR/PowerSDR_mRX icon is not
clearly apparent on your screen, use your start menu to locate the program.

The program will begin with by optimizing the FFT3 DSP code called “WISDOM”. A DOS screen FFT 
optimization screen will appear. Please Wait for this process to finish and the DOS screen will disappear. 

Wait for the message that it is OK.  This may take several minutes on a your particular computer.

Turn on your power supply. Push the POWER ON button on the ANAN Transceiver. 

The IDLE receiver current of the ANAN-8000DLE is approximately 1800ma [1.8A]
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PowerSDR mRX PS Installation Wizard

Be sure to select the 8000DLE Transceiver model.
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PowerSDR mRX PS main window display

Open the PowerSDR program, then press the POWER button on OpenHPSDR/PowerSDR™.

Wait a few seconds for Network Discovery and then click on the Setup Menu selection. 
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PowerSDR mRX PS Setup Menu

Go to → GENERAL → Hardware Configuration tab and note the IP Address and MAC address that are read from 
the ANAN Transceiver EEPROM.

Note: if the IP ADDRESS is 0.0.0.0 then the software is not communicating with the Transceiver
check your LAN connection.
OpenHPSDR/PowerSDR/OpenHPSDR software has not been started
Power button on the rig has not been activated
The RJ-45 LAN connector has two LED indicator lights. On the back panel of the 8000DLE check your 
LAN connector to insure that the GREEN Link Light on the RIGHT side of the LAN connector is 
illuminated. The orange/yellow DATA Light on the LEFT side of the LAN connector will blink as data is 
transferred to/from the PC
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PowerSDR mRX PS IP address

Make a note of your ANAN Transceivers unique MAC address since this will be useful if you need to debug a 
network problem in the future.

Note: Make sure you have selected the proper radio model from the selections on the LEFT side of the 
Hardware Configuration box. Failure to do so will result in an improper set of menu options and displays.

The Static IP Addresses are available to point your instance of OpenHPSDR/PowerSDR/OpenHPSDR to a 
particular Apache Transceiver. There may be several Transceivers on your LAN and the Static IP address is a 
convenience for pointing this software to a particular unit – where each unit has it's own IP address.

Setup ---> General tab ---> Hardware Config tab, the Radio Model should have ANAN Transceiver selected. 
Connection Type “ANAN” and “Full Network Discovery” should both be checked. In the “Region”, select the
Country in which you reside. 

The ANAN IP address and Firmware version number in the green box highlighted above will be set automatically
by your network router DHCP server, or if connected directly to your PC, the IP address will be assigned by the 
“APIPA” process – WHICH MAY TAKE UP TO SEVERAL MINUTES TO ASSIGN AN IP ADDRESS.

If your LAN is properly configured, the ANAN Transceiver board IP ADDRESS and MAC ADDRESS should be 

automatically be detected and assigned. An incorrect default value is 169.254.1XX.XXX. 

OpenHPSDR/PowerSDR™ will display the currently assigned IP address and MAC address of the ANAN 

Transceiver Hermes board if the LAN connection is properly connected and configured. If the ANAN 

Transceiver IP ADDRESS remains 0.0.0.0 then you must determine if OpenHPSDR/PowerSDR and your PC 

network connection is operating correctly. Some typical problems could be that the Ethernet connection to 

your PC or LAN connector is disabled in Windows. The Ethernet connector may not be properly seated in 

your PC or Router. DHCP addressing must be properly enabled on your router. The new HPSDRProgrammer 

V2 utility allows you to assign a STATIC IP ADDRESS if you wish.

Please see APIPA appendix of this document for more information.
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PowerSDR mRX PS

The cluttered and dense Chicago AM Broadcast band
shown using 3 x 384khz for RX1 
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4.  SSB Phone Operation
Connecting a suitable Microphone

Most “Computer Condenser” microphones will work when directly plugged into the MIC connector on the front 
panel of the Apache Transceiver.  The Factory settings for Apache Transceivers is to have a small positive 
voltage applied to the TIP of the connector for powering a condenser microphone. The RING is connected
to push-to-talk, and the SLEEVE is connected to the Transceiver analog ground.  The SPACE BAR of your 
keyboard acts as the default push-to-talk for all microphones. A Computer Condenser mic without a push-to-
talk switch can easily be used by substituting the SPACE BAR of your KEYBOARD.

Example: here is a link to a $3 USD microphone using the keyboard space bar for push-to-talk:
http://www.officedepot.com/a/products/969486/Cyber-Acoustics-ACM-51-Boom-Microphone/

The 8000DLE software beginning with PowerSDR mRX PS v3.3.10 includes a very convenient new Setup window
with individual selection of Tip, Ring, and Sleeve settings. 
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MIC Adapters

A Ham style, multi-pin microphone requires an adapter. Various adapters are readily available or can
be wired to the Apache 1/8” Stereo style MIC socket.  

The original ANAN Users Guide has several detailed paragraphs about adapters. The Apache Labs 
Yahoo Group Files section also has good information about MIC connections and alternatives such 
as Headsets using a Virtual Audio Cable [VAC] utility or “VB-Audio”.

Microphone Connector Database
http://www.qsl.net/g4wpw/date.html

Bhanu VU2MB recommends the inexpensive Koss-SB-40 headset that plugs directly into the front panel of the 
new ANAN-8000DLE. He is getting rave reviews on the quality of his Audio on SSB phone.

Subject: [apache-labs] PowerSDR_mRX Audio Chain - How it works

From: Warren C. Pratt <warren@wpratt.com>

There has been quite a bit of discussion lately of MIC sensitivity and the audio processing in the mRX release. I 
think a few words of explanation about how things work might be helpful to those exploring various situations 
and alternatives.

In the case audio enters the MIC connector, it is fairly quickly routed to an audio CODEC to be converted to 
digital samples. Within that chip, before the ADC, there is a 20dB gain block that can be switched OFF/ON. This 
gain block is the 20dB Mic Boost that can be selected. Although I haven't tried, I suppose it's possible to 
overdrive the input stages or

ADC [especially with the 20dB gain block enabled] which could result in clipping of the digital data and resulting 
distortion.

After conversion to digital, the 16-bit, 48Khz samples are transferred to the computer where they are promptly 
converted to floating point. With floating point samples, dynamic range is of little consequence as they then 
progress through the digital signal processing chain. The processing chain is then as follows:

MIC GAIN - a simple multiplier determined by your gain settings is applied to the samples.

DOWNWARD EXPANDER - If activated, the signal is reduced in gain if it is below the threshold set on the 
console.

GRAPHIC EQUALIZER - If activated, a filter is applied to the audio. The frequency response of the filter is 
tailored to the response curve that has been set.

LEVELER - If activated, the specified leveler gain is applied to the audio if/when the signal level is running 
below the leveler's output target amplitude. I currently have the output target set to +0.4 dB. Why not 0 dB? 
The slight positive bias is beneficial for upcoming features. [Note: NOT the same algorithm that Flex used.]

COMPRESSOR - If activated, the specified maximum compression is applied. Output is compressed to 0dB 
maximum. [NOTE: Not the compander algorithm that Flex used.]

FILTER - The audio is filtered to match the transmit bandwidth.

ALC - The audio is restricted to 0dB so as not to over-drive the fixed-point dynamic range of the FPGA and/or 
the DAC. [NOTE: Not the same algorithm used by Flex.]

Finally the audio is converted to 16-bit, 48Khz, samples and transferred to the hardware for up-conversion.

What happens if you run your MIC level above 0dB? If the Leveler is ON, you will get some compression there 
and everything else runs as normal. If the Leveler is NOT on but the compressor IS, you will get some additional
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compression there, above the value you have selected. If neither the Leveler or Compressor is ON, you will get 
some compression by the ALC. IN NO EVENT does the compression cause "flat-topping" or "splatter." These 
phenomena only result from non-linearity and overdrive of the analog amplifiers. Note that the ALC has no 
knowledge of the analog amplifiers--it is strictly in the digital signal

processing chain.

73,

Warren NR0V
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Setting up PowerSDR for Phone Operation

With the rig powered on and PowerSDR software running, you should hear great audio from your speakers or 
headphones connected to the front panel “headphone” jack. 

Select modulation mode of USB or LSB at the right, center of the OpenHPSDR/PowerSDR window.

Selecting Transmit Profile

The "Profiles" drop down menu allows you select various transmit profiles. The default profile is "Default".  You 
can modify profile settings on this tab and save them to a profile name you select, or you can just modify the 
included profiles to your liking. You can recall saved profiles at a later time.

Adjusting mic gain

You should make all microphone adjustments using a Dummy Load with proper PA Calibration.

Select Setup –-> Transmit the default Source is "Mic In".

Locate the "MIC" gain control slider. It is located at lower right, below the panadapter. The present mic gain 
setting is shown just to the right of the MIC gain slider.
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On the OpenHPSDR/PowerSDR main window, use the "TX meter" [Upper right corner] dropdown box to select 
"Mic".

Press your Mic PTT button, keyboard space bar, or click the "MOX" button on the main form to key the radio. 
With the radio keyed and while speaking into the mic in a normal voice adjust mic gain for peaks
0db.

If 0 db voice peaks cannot be achieved with the slider at the extreme right, go to the Setup, transmit tab [lower 
left], check "20db mic boost" and try again to adjust the "MIC" gain control on the main 
OpenHPSDR/PowerSDR window for 0 db on voice peaks.

If you are still unable to achieve 0 db on voice peaks:

  [a] Check your JP4, JP5 and JP6 jumper settings on the Hermes board.

  [b] Try a different mic.

To enable or disable COMPRESSION you click on the COMP button. We recommend that you set 
COMPRESSION to no more than 6dB.
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Tune

The "Tune Power[%]" spinner allows you to select the power output used when the "TUN" button is pressed on 
the main OpenHPSDR/PowerSDR window. In some versions of OpenHPSDR/PowerSDR, this is actually a 
percentage of power output rather than output in Watts. The "Tun" button places OpenHPSDR/PowerSDR in CW
mode and keys the transmitter using the specified power output level.

The "TX Meter:" drop down selects what the TX Meter on the main form displays when the "Tun" button is 
pressed.

VOX

Click the "enabled" button to enable "Voice Operating Transmit" if you want to cause the transmitter to key 
when you speak.

Set the sensitivity spinner to a higher value if your wish to have a higher voice level cause the transmitter to 
key.

Set the delay to cause the VOX to de-key the transmitter after not hearing voice for "Delay [ms]" milliseconds.

Use this with care. Local noises [dog barking, TV playing, door bell, computer sounds] can cause your 
transmitter to key when you do not want this to happen. Extreme cases can cause your transmitter to key for 
excessive periods of time resulting in damage to your radio and attached power amplifier.

Transmit Filter

This filter tailors the transmitting frequency response in voice modes.

The default for high is 3100hz in some versions of OpenHPSDR/PowerSDR.

This value exceeds the frequency response allowed on 60 meters in some regions.

You can modify this and other values as needed before hitting the "Save" profile button to save to disk for later
recall.
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HPF/LPF Filters and switching 

The ANAN-8000DLE has a very effective set of High Pass Filters [HPF] and Low Pass Filters [LPF], available on 
the Setup, General, Ant/Filters/HPF/LPF tab. 

Note: There are SEPARATE HPF/LPF selected for use with Rx2.  In this picture you see new tabs for
the 8000DLE BPF1/LPF and BPF2.  Please carefully examine the default settings for the new filters.

The HPF and LPF are automatically selected as you change bands, according to the settings on this form.

The ByPass check box on the left side of the HPF/LPF tab, when checked, removes the selected high pass filter 
from the receive path. 

The values in the up/down boxes control the frequency ranges when these filters are automatically selected. 

The 6m BPF/LNA bypass check mark controls the 6 meter low noise amplifier and filtering.

The ByPass/55mhz HPF check mark, when enabled bypasses all high pass filters.

The active buttons displayed between the HPF and LPF show which filters are currently active.

The Auto/Manual radio buttons should be left in Auto mode for most operations. Selecting manual will allow you
to see what receive filters are selected when you bypass or change receiver frequency ranges etc.

Note: there are new “Disable HF PA” and “Gnd BPF2 on Tx” check boxes on this Setup Antennas 
and Filters page.
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Antenna Control menu allows you to control the following options:

Software SWR Protection will reduce power output when high SWR levels are detected.

Disable on Tune Pwr < 10W will disable Software SWR protection when the Tune power level is less than 10 
watts. The Tune power level can be set on the Setup, Transmit tab.

ATT on TX. This option inserts attenuation in the receiver when the ANAN-* is transmitting. This can prevent or 
reduce the ADC/Receiver overload warnings during transmit.

RX 1 Out on Tx. This option switches the receive path from ANT[n] to the rear panel Bypass connector.

ANAN-8000DLE users may wish to manually DISABLE THE PA (front panel STANDBY switch, or via Setup 
Transmitter menu) calibrate the Transmitter Power Output settings within PowerSDR mRX PS software in the 
Setup → PA Settings menu. 
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5.  CW Operation
Sample Rate

Select a SAMPLE RATE best suited to your CW tuning style from the Settings → AUDIO menu

(although this shows the AUDIO menu, it is an historical reference to the original Flex SDR-1000TM which used 
Audio Sound Cards as the interface for Digital Signal Processing.  In all modern Apache Transceivers, the 
architecture is digital with Direct Down Conversion. Sample Rates are handled by the high speed FPGA (Field
Programmable Gate Array) chip inside the radio on the Transceiver board)

the appearance of the Panadapter can be adjusted with the ZOOM settings, Sample Rate, and 
SETUP –-> DISPLAY –-> RX1 [or RX2] –-> Fast Fourier Transform Size [min to max] Bin width.

Note: in the New Ethernet Protocol for the 8000DLE, there are many new features including 
Independent Sample Rates for each Receiver chain.
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1 Iambic A/B

Select Iambic A or B from the Settings → DSP → CW menu

Note: Unselecting Iambic allows you to use the Paddle input in “Bug” mode or with a Straight Key connected to 
the DAH paddle input. 
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Paddle Connection

Plug your favorite paddles into the front or back panel.

To use a CW key with OpenHPSDR/PowerSDR™ you will need to enable it in the menu. To do so, click 
on Setup → DSP tab followed by the Keyer tab.

Provides connection for a CW key, either straight, single-paddle or Iambic. If using dual-paddle or 
Iambic mode, the common connection of the key should be made to the sleeve of a 3.5mm 1/8” stereo 
plug, the “dot” side to the ring and the “dash” side to the tip. If a straight key is used, this should be 
connected between the sleeve and the tip of the plug. PowerSDR Software enables the dot and dash 
connections to be reversed via a menu selection [above]. The dot and dash connections are connected 
to a 3.3vdc via a 1k resistor.

If you find that your DAH and DIT paddles are reversed, there is a very convenient SETUP check box to put 
DAH on tip and DIT on Ring of the input PLUG

CWU/CWL

Select CWLower or CWUpper from the MODE buttons in the main window. Note the position of the filter 
changes in the main window.
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Select Operating Frequency

Using your mouse on the PANADAPTER display, select your operating frequency.

Note that you can see your CW [BFO] CENTER FREQUENCY or TX FREQUENCY by checking the boxes on the 
main screen. Those convenient vertical yellow marker-lines are really great when you are working split. The 
SPEED of the internal Iambic Keyer is shown at the top of this picture.

Set Drive Level

Set the DRIVE LEVEL slider to 50% [mid range].
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Break-in Delay

You may wish to start with the default CW DELAY setting of 300ms. That value gives you plenty of time to 
complete words without tripping the T/R circuit at 20WPM. Set the DELAY to a value that best suits your 
comfortable operating speed. 
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Sidetone Level

On a Dummy Load try sending some code and see if the sidetone is at a comfortable level. The MASTER 

VOLUME slider [upper left] is ALSO the SIDETONE LEVEL setting when you are in Transmit. 
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Antenna

Connect a good antenna [that is resonant on your favorite band] to ANT-1

Use the Antenna Control settings DEFAULT values until you have more experience with your new 
Transceiver.

Note the Antenna Control menu allows you to control the following options:

1. Software SWR Protection will reduce power output when high SWR levels are detected.

2. Disable on Tune Pwr < 10W will disable Software SWR protection when the Tune power level is less than 10 
watts. The Tune power level can be set on the Setup, Transmit tab.

3. ATT on TX. This option inserts attenuation in the receiver when the ANAN-* is transmitting. This can prevent 
or reduce the ADC/Receiver overload warnings during transmit.

4. RX 1 Out on Tx. This option switches the receive path from ANT[n] to the rear panel Bypass connector.

5. Disable ANAN PA [only functional via the XVTR form]
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Tuning

Methods for tuning your Transceiver to a frequency

The ANAN-8000DLE ADC samples the entire spectrum from 10khz through approximately 61.44 Mhz. The 
receivers are implemented in the FPGA where their data is decimated to an amount of spectrum suitable to send
over Ethernet to your PC.  If you have an antenna that will receive all those frequencies [like a vertical, loop, or 
dipole) you can tune your Rx1 and Rx2 to independent bandwidths [selected by the Sample Rate) and 
frequencies at the same time. 

Rx1 might be on your Left speakers [or headphones) and Rx2 might be on the right speaker with easy front 
panel PowerSDR controls. MultiRx feature a second receiver within the passband of the primary receiver.  Rx2 
will be undisturbed by the MultiRx and will continue to receive it's  independent band and frequency. Take note 
of the Multi and Rx2 controls in the main Window of PowerSDR.

Direct numeric input 

Keyboard commands – see Setup → Keyboard menu

Point and Click with Mouse
The mouse can be used to tune signals on the Waterfall or Panadapter. Select an active amateur band by 
clicking on one of the band buttons located just below the "S Meter" in the upper right portion of the 
OpenHPSDR/PowerSDR window. 

If you right click the mouse on the Panadapter you can go into "click tune" mode. The display will show a yellow
indicator tuning line and filter width setting.  Left clicking with the mouse will then QSY the receiver to that 
frequency. You can right click again to revert from "click tune" mode to "drag" tuning mode.

The "Zoom" slider and the "0.5x, 1x, 2x and 4x" buttons can be used to modify the frequency range displayed in
the Panadapter. These controls are located just below the Panadapter/waterfall display. The "Pan" button can 
be used to move the displayed frequencies within the selected range.

Drag Mouse
If you press and hold the left mouse button you can "drag" the frequency of interest into the panadapter 
highlighted filter area.

Roll Mouse Wheel – see main window TUNE STEP selections
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CTUNE

The PowerSDR "CTUN" button enables "Click Tuning" while using the panadapter and waterfall displays. "Click 
tuning" when active, allows you to click within the Panadapter or waterfall to QSY without shifting the 
Panadapter or Waterfall display. When "CTUN" is inactive, clicking on the Panadapter re-centers the panadapter,
thereby shifting the entire panadapter. Note that the " CTUN" function only works within a frequency range 
equal to the sample rate. IOW, if the selected sample rate is 384khz and RX1 panadapter is 1 MHz, wide, CTUN 
will only function within the center 384khz of the panadapter or waterfall display.

DUP

The PowerSDR "DUP" [DUPLEX] button enables RX1 reception during transmit, allowing the user to view the 
transmitted RF signal in the Panadapter. The ANAN-8000DLE transceivers switch the selected antenna [ANT1, 
ANT2, or ANT3] to ground during transmit, thereby protecting the receiver from damage due to high RF levels. 
Monitoring of the RF transmission using the "DUP" feature is visible in the Panadapter and Panafall modes.

LOCK VFO – prevents an unintended change of VFO frequency while in a QSO 
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Tune/SWR/Output

Select the TUNE button to see your SWR and OUTPUT wattage on the main screen display. The TX display is in 
the upper right corner of the main window. Select various meter options to see which one suits your operating 
style. I frequently use SWR and OUTPUT WATTS when on CW. 
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PA Drive Level Calibration

If you have not yet completed a MANUAL PA CALIBRATION, then the output may be a above or below 
your desired DRIVE slider setting.   

Note: the Drive Level is a percentage and not the numerical watts output.
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6.  Linear Amplifier connection
PTT Input

Most modern Linear Amplifiers have a connection for PTT input for keying the Linear. Apache Transceivers 
include a back panel connection for this purpose and it is activated by the PowerSDR software based on menu 
preferences.  On the ANAN-8000DLE Linear Amplifier PTT OUT it is pin 1 of the AUX I/O Ribbon connector.

FET

The PTT OUT is a common DRAIN 2n7002 type FET transistor as shown in the schematic for the ANAN-
8000DLE.

The heavy duty type FET is best used to switch 25vdc and 800ma [or less). Exceeding these values may 
damage the PTT OUTPUT circuit.

How to test your PTT Linear Amplifier circuit BEFORE connecting your Apache Transceiver.

Power your Linear, connect the control cable to your linear but do not connect the other end to your 
Apache Transceiver

Using a DC Voltmeter, measure the voltage between the center pin and the outer connection of the 
cable. This must be less than 25vdc.

Connect a DC Ammeter between the center pin and the exciter connection of the cable. This should 
ACTIVATE the Linear Amplifier and give you a clear measurement of the current requirements. The 
ANAN-8000DLE PTT circuit should not draw more than 800ma.

 If either of these values are out of the required range, then use an external keying interface. There are 
many keying interfaces available from many sources such as MFJ, Elecraft, DX Engineering.

Important: Connecting a Linear Amplifier that does not meet the above voltage and current 
requirements is likely to cause damage to the Apache Transceiver linear switching transistor and 
extreme cases, serious damage to other parts.  Damage to the radio caused in this manner is not 
covered by Warranty.

Various Linear Amplifier Keying ISOLATION adapters are available

http://www.dxengineering.com/search/product-line/kd9sv-products-sv-kr-keying-relays

http://www.ameritron.com/Product.php?productid=ARB-704

http://www.sultantronics.com/product.html

http://stores.ebay.com/radiodan-w7rf?_trksid=p2047675.l2563

ALC

K2UE has written a helpful document about how he uses ALC with his Apache Transceiver. You can find 
it in the Apache Yahoo Group FILES section:  

https://xa.yimg.com/df/apache-labs/ExtALC+Installation+%26+Use.pdf

For more information about suitable couplers from the KC9XG Yahoo Group Files section:
https://xa.yimg.com/df/KC9XG-SDR/PSSamplersCouplers.pdf
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Various directional coupler models are available

ac2iqdave@gmail.com

In practice, the ANAN-8000DLE works well with PureSignal with no external RF Sampler when running 10W.  
You will need to determine the suitability of your Linear Amplifier to the modes you wish to operate.

Automatic Band Selection can be accomplished using the Open Collector Output transistors available on the AUX
I/O Connector on the back panel.  DDUTIL?

VK6PH example OpenCollector BCD keying

This is an example provided by Phil Harman VK6PH of how to code the OpenHPSDR/PowerSDR/OpenHPSDR 
Power_mRX program to give a BCD [binary coded decimal] output for control of external equipment [such as 
band information for a Linear Amplifier]. 

The utility “DDUTIL” may also prove useful and can be found here:  
http://k5fr.com/ddutilwiki/index.php?title=Main_Page
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7.  PureSignal Adaptive pre-distortion information

PureSignal Predistortion

Note that on the  back panel of the 8000 you will see two new SMA connectors. These are connected together 
at the factory with a small coaxial jumper. The jumper connects the INTERNAL RF Sampler to the RF Sampler 
INPUT for PowerSDR PureSignal.  That jumper can be easily removed giving you access to an external coupler.
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Warren Pratt NRØV PureSignal Information

Linearity of an amplifier implies that the output increases linearly with increases of the input signal. i.e., if an 
input of 5W produces an output of 50W, then an input of 10W should produce an output of 10W.

Unfortunately, the analog amplifiers in our power amplifier stages are not so perfect.  A real amplifier might 
behave more like the figure below.

The unfortunate side-effect of this NON-linearity is Inter-Modulation Distortion [IMD], some of which results in 
“splatter.”  Consequently, on the Panadapters of our SDRs it’s easy to see signals that extend outside a normal 
transmit bandwidth.  This phenomenon is more evident on strong signals as the IMD may be 25dB or more 
down from the peak of the signal.  This IMD pollutes our bands and raises the interference and noise levels for 
amateurs that may be operating many kilohertz away from the offending transmitters.  Some of the IMD is less 
visible on Panadapters because it falls IN-BAND, i.e., within the bandwidth of the transmitted signal.  This adds 
distortion to the signal.

Fortunately, several techniques have been developed to improve the linearity of analog amplifiers and thereby 
reduce the IMD levels that they generate.  One such method is “Predistortion”—making the amplifier’s output 
more linear by “predistorting” the input signal in such a way as to offset the distortion that the amplifier will 
produce.  The output of the amplifier can therefore be corrected to behave very much like the ideal case shown 
above.

Editorial note:  IMD robs you of the value of an expensive Linear Amplifier by needlessly pumping out bad 
Energy in opposite sideband and IMD splatter.

How to Use PureSignal Adaptive Predistortion

When you have your Transceiver operating properly for SSB communication [Mic, Drive, PA, Filters, 
Profile) you are ready to improve your Tx signal quality. 

Select the Linearity tab at the top of the Main PowerSDR Window

Select the INFORMATION link or button at the top of the PureSignal control window.

If your PC is setup properly, PureSignal will automatically open a new Window displaying a detailed text 
and graphics pfd document Introduction and explanation by Warren Prat NRØV
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please take the time to read [and print out) this excellent document. You will have the best results and 
enjoy improved signal quality and performance by following Warren's instructions. 

With the new automatic adjustment feature, Warren has dramatically improved PureSignal so that it is 
now even easier to use on a routine basis.
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In PowerSDR release 3.3.10 Warren has introduced a sophisticated new version 2.0 with many automatic 
features. 

This was previously done manually by the operator using Setup ---> General ---> Ant/Filt and adjusting the 
thumb wheel value of ATT on TX [as shown below) while watching for a GREEN Feedback Level in the 
Linearization window indicating that you have sufficient feedback RF signal for PureSignal to measure, evaluate, 
and correct with Adaptive Distortion techniques in the DAC Tx signal.

Using a DUMMY LOAD and your Panadapter set for DUP, you can activate the TWO TONE button in the 
PureSignal Window.  You should immediately see your transmitted signal displayed with the primary and odd 
harmonic peaks. PureSignal will adjust your ATT on Tx for an optimal value and then in just a few seconds it will
lower your 3rd ,5th ,7th  harmonic peaks to a surprisingly lower level. PureSignal can optimally adjust unwanted 
IMD by as much as -45dbc. PureSignal will continue to optimize your signal as you speak in a normal voice. 
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PowerSDR Release github Webpage

There is also a newly established github repository where you can find PowerSDR releases.

Link:  PowerSDR github Release Webpage

Copyright Apache Labs © ANAN-8000DLE 55 15 March 2017 

https://github.com/TAPR/OpenHPSDR-PowerSDR/releases
https://github.com/TAPR/OpenHPSDR-PowerSDR/releases


Power SDR Download github version 3.3.11 webpage

Link: PowerSDR release Download Webpage
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Reference materials

Apache Labs International Support

Technical support for ANAN-8000DLE from the factory is available via the Apache Labs Yahoo Group 
http://groups.yahoo.com/group/apache-labs/ 

or directly via email <support@apache-labs.com>

Apache Yahoo Support Group

http://groups.yahoo.com/group/apache-labs/ 

OpenHPSDR Group

Instructions relating to joining the OpenHPSDR Group reflector are here:

OpenHPSDR Email Archive

The OpenHPSDR archives may also be searched here:

OpenHPSDR Organization

The latest version of the OpenHPSDR User Manual can be obtained from

OpenHPSDR Documents webpage Revision 1.9 Author Phil Harman VK6PH

Apache Service and Repair

1023 Tower B4, Spaze I-Tech Park

Sector - 49, Sohna Road

Gurgaon - 122001

Haryana, India

Tel: 91-0124-4245173/4/5 [10AM - 6PM IST]

Email: support@apache-labs.com

Website: http://www.apache-labs.com

Apache Schematics

The current Apache ANAN-8000DLE schematic are available on special request from Apache Labs LLC.

Original 2013 Users Guide

Please refer to the Technical Reference document [formerly User Guide v3.4] for information about various 
microphones and how to adapt them to the Apache Transceiver. You may find this reference helpful:

Website: Apache-Labs Website
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Balanced Audio Input is not implemented in the current Apache Labs Transceivers.

The LEFT LINE level input is currently selectable in PowerSDR as an alternative to the mic input.
Balanced audio is not supported by the Audio ADC hardware used in the ANAN radios. If a balanced input is 
required then an external balanced to unbalanced transformer [or active electronic equivalent] will be required.

Multiple independent .xml databases

Thank you Doug W5WC for this important information.
Go to the Properties of the shortcut.

At the end of the Target you can add the new directory path using the
command line argument –datapath:<”directory path”>

To create a new directory for the ANAN-8000DLE radio I use the name PowerSDR
ANAN_10 like this:

start -datapath:"%appdata%\FlexRadio Systems\PowerSDR ANAN_10\"

My new Target will look like this:

"C:\Program Files [x86]\OpenHPSDR\PowerSDR RX2 [W5WC]\PowerSDR.exe"
-datapath:"%appdata%\FlexRadio Systems\PowerSDR mRX\"

When you start PowerSDR using the modified shortcut you will receive
this message the first time.

Ensure the directory path is correct. The click on Yes.

You will then get the normal startup with a new wisdom file and database
created in the new folder.
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Manual Calibration Procedure

Use the following manual calibration procedure to properly set/calibrate your ANAN-8000DLE power output into 
a dummy load:

1. Connect a suitable Dummy Load to ANT1 BNC port on the back panel of the Transceiver.

2. Click on menu selection, Setup, Transmit.

3. Set “TUNE”, Power % to 100

4. Select “FWD Pwr” from the “TX Meter” upper right corner of the main OpenHPSDR/PowerSDR/OpenHPSDR 
window.

5. Enable the Antenna window by clicking on Setup ---> General ---> ANT/FILTERS tab to access the antenna 
settings.

6. Select the Transmit antenna ANT1 where you connected the Dummy Load.

7. Select the PA settings TAB on the Setup menu window.

The PA Settings TAB allows you to set [calibrate] the ANAN-8000DLE Power Amplifier gain by band [dB – Power
Output per Band] for each of the available Ham Bands. There is an up/down gain control for each band, which 
regulates the Power Amplifier output for that band. As you increase the Gain By Band, power output will 
decrease. Conversely, decreasing Gain By Band will increase Power Amplifier output.

Maximum power output per band can be reached at the lowest value in this menu.

8. Select one of the bands on the PA settings TAB.
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9. Ensure you have the Setup ---> Transmit tab ---> Tune control set to 10 and a Dummy Load connected to 
the selected antenna port on the ANT/FILTERS setup tab.

10. Press “TUN” [Tune] on the upper left side of the OpenHPSDR/PowerSDR
main display form on your computer.

11. Adjust the band gain value for a MAXIMUM TX Meter “FWD PWR” output
reading of 10 watts while using your suitable Dummy Load. Do NOT use an
Antenna for this calibration adjustment.

12. Press “TUN” button again to unkey the radio.

Repeat the above procedure for each Ham Band to properly calibrate the RF CW
power output for a MAXIMUM 10 watts.

13. When all bands have been calibrated, remove the Dummy Load and select
the antenna of your choice in the ANT/FILTERS setup Tab.

14. Remember to reduce the “TUN” power wattage setting on the Setup ---> Transmit tab to approximately 9W.

Computer Performance

Processing of streaming data in real-time can be a challenging task for Windows-based applications and device 
drivers. This is because by design Windows is not a real-time operating system. There is no guarantee that tasks
can be executed in a deterministic [timely] manner.

Audio or video data streams transferred from or to an external device are typically handled by a kernel-mode 
device driver. Data processing in such device drivers is interrupt-driven.

Typically, the external hardware periodically issues interrupts to request the driver to transfer the next block of 
data. In Windows NT-based systems [Windows 2000 and later] there is a specific interrupt handling mechanism.
When a device driver cannot process data immediately in its interrupt routine, it schedules a Deferred Procedure
Call [DPC]. Microsoft defines them as: A Deferred Procedure Call [DPC] is a queued call to a kernel mode 
function that will usually be executed at a later time. DPCs are used by drivers to schedule I/O operations that 
do not have to take place in an ISR at a high IRQL, and can instead be safely postponed until the processor 
IRQL has been lowered. When you look at Windows Task Manager and sort the running processes by CPU 
[Processor Utilization], the System Idle Process is almost always at the top of the list. What you may not know is
that ‘process’ is really a roll-up of several things. Among other things included in that CPU number, is hardware 
interrupts and DPCs. You can see these two items by using the Microsoft “SysInternals” Process Explorer 
available here: Process Explorer 

The Sycon's DPC Latency Checker is a free Windows tool that analyzes the capabilities of a computer system to 
handle real-time data streams properly. It may help you to determine if your personal computer is capable of 
powering your HPSDR system or to find the cause for interruptions in real-time audio and video streams, also 
known as ‘drop-outs’. The program supports Windows 2000, Windows XP, Windows XP x64, Windows Server 
2003, Windows Server 2003 x64, Windows Vista, Windows Vista x64, Windows 7 32 bit and 64 bit and is 
available here. Latency checker found by N9VV

http://www.resplendence.com/latencymon
and
http://www.thesycon.de/deu/latency_check.shtml
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Warranty

We warrant that our products are free of defects in material and workmanship and extend this warranty under 
intended use and normal service conditions to the original owner for a period of one year from the date of 
purchase. This warranty does not apply to any product that has been repaired [Unauthorized] or altered in any 
manner and is void if damaged by accident, neglect, unreasonable use, improper installation, lack of proper 
impedance matching [High SWR], improper tuning, over driving power limits, damage due to use of any third 
party accessories, or any other cause not arising specifically out of defects in material or workmanship.

Our obligations are limited to repairing or replacing, at our sole discretion, any product or part that is returned 
to the mailing address, all shipping or transportation charges must be pre-paid, accompanied by proof of 
purchase and which examination reveals to have been defective within the warranty period stated above.

Our Warranty does not imply any obligation other than herein stated. Any implied warranties, including but not 
limited to fitness for a particular purpose, are limited in duration for the above one year period.

We shall not be liable under this warranty, or any implied warranty, for loss of use of the product or for any 
other consequential loss or damage incurred by the purchaser.

Warranty -- Apache Labs website has a link to explain their warranty and other pertinent information:
http://www.apache-labs.com/terms-of-use.html under "Terms of Use".

IMPORTANT

The FPGA and other components on the ANAN-8000DLE PCBs can be damaged by Electrostatic Discharge [ESD].
When handling the PCB, you should take ESD precautions [e.g. use a work bench with an antistatic mat on it 
and wear a grounded wrist strap].

When powered on do not touch the top of any IC in order to determine its temperature. In particular, do not 
touch the Switch Mode Regulator IC. Touching its leads can change the switching frequency and alter the output
voltage.
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MARS operation

In PowerSDR select Settings → General → Hardware Config → Region you will be able to select band limits by 
country or Region. Use care in selecting the “Extended” Region. 

APIPA Automatic Private IP Addressing

Definition: APIPA is a DHCP failover mechanism for local networks. With APIPA, DHCP clients can obtain IP 
addresses when DHCP servers are non-functional. APIPA exists in all modern versions of Windows.  If your new 
ANAN-8000DLE Transceiver is connected directly to your PC, you will probably get an APIPA address. 

If  a DHCP server fails, APIPA allocates IP addresses in the private range 169.254.0.1 to 169.254.255.254. When
the DHCP server is again able to service requests, clients update their addresses automatically.

In APIPA, all devices use the default network mask 255.255.0.0 and all reside on the same subnet.

APIPA is enabled on all DHCP clients in Windows unless the computer's Registry is modified to disable it. APIPA 
can be enabled on individual network adapters.

Your current IP address, Netmask, Firmware revision, and MAC address are all clearly displayed on the main 
SETUP –→ General –→ Hardware Config menu panel [shown below].
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Apache Labs ANAN-8000DLE PCB (from brochure)
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ANAN-8000DLE PA Filter PCB (from brochure)
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ANAN-8000DLE PA and Filters (from brochure)
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Apache Labs ANAN-8000DLE  (from brochure)
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Appendix  - independent versions of PowerSDR software
Thank you Doug W5WC for this information.

Instructions to load independent versions on a single PC are summarized here:

Go to the Properties of the shortcut.

At the end of the Target you can add the new directory path using the command line argument 
–datapath:<”directory path”>

To create a new directory for the ANAN-8000DLE radio I use the name PowerSDR like this:

start --datapath:"%appdata%\FlexRadio Systems\PowerSDR ANAN_10\"

The new Target will look like this (all on one line):

"C:\Program Files [x86]\OpenHPSDR\PowerSDR RX2 [W5WC]\PowerSDR.exe"

--datapath:"%appdata%\FlexRadio Systems\PowerSDR mRX\"

When you start PowerSDR using the modified shortcut you will receive this message the first time.

Ensure the directory path is correct. The click on Yes.

You will then get the normal startup with a new wisdom file and database created in the new folder.

Each installation of PowerSDR makes entries in BOTH the %appdata% and Program Files (x86) folders. If you 
install a new version, it will override the XML DataBase that contains the detailed description of all your settings 
and preferences. 

At this time, there is no utility to retain your preferences and apply them to the next revision database.
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Appendix - Updating the ANAN-8000DLE Firmware
Explanation of the bootloader normal operation

The bootloader code fits in EEPROM from 0 to 1MB. The FPGA Firmware firmware fits in the address range from 
1MB to 2MB. 

When power is applied, the board starts to reads from address 0 i.e. the bootloader code. If the REAR PANEL 
Bootloader switch is in the DEFAULT (OFF) position, then the bootloader code is executed and the bootloader 
enables the FPGA to read from the 1MB boundary and hence installs the ANAN-8000DLE firmware code.  This 
happens in a fraction of a second and is usually invisible to the End-User.  

[Note: There is an FPGA “Heartbeat” LED located on the back of the Transceiver PCB that will blink every second to indicate that the FPGA 
firmware is properly installed an active for communication with the LCD Panel microprocessor. That LED can be viewed by removing the 
bottom cover of the Transceiver]

When running the HPSDRBootloader_v2.0.4.4 utility, you can update the FPGA Firmware code loaded beginning 
at the 1MB address in the EEPROM. The update files are available at: 
http://k5so.com/HPSDR_downloads.html in the section marked “Orion MkII ANAN-8000DLE”.  Firmware
Update files have the “.rbf” suffix. The update OpenHPSDRBootloader utility is specifically protected so you can 
not inadvertently overwrite or damage the lower bootloader addresses. 

Full recovery from a catastrophic loss of EEPROM code is accomplished by Factory Trained repair personnel 
using the ByteBlaster USB device in concert with the appropriate ALTERA software.  The USB ByteBlaster is used
to load the entire EEPROM from a “.pof” suffix file. 
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HPSDRBootloader 2.0.4.4 Utility

The OpenHPSDR Bootloader utility was created by Dave KV0S. It can be downloaded for Windows here: 

OpenHPSDR Bootloader for Windows

Here are the steps to successfully use the HPSDR Bootloader 2.0.4.4

Once you have successfully installed the Utility, you are presented with the following window(s):
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Please do not attempt the Firmware upgrade if you are unsure about the reason for the 
update and the benefit to operation of your ANAN-8000DLE. Apache Labs Support is ready to 
receive your email requesting assistance.

This section will suggest the current best method to install Firmware (FPGA) updates for your
8000DLE.

If you need a ByteBlaster

The “ByteBlaster” was used on the original Hermes in order to recover from a clocking or “bricked” circumstance
where the Transceiver board is not recognized by any software. 

The ByteBlaster is a small USB to JTAG level converter that conveniently connects between the Altera FPGA 
Software utility and the P2 connector on the Transceiver PCB. The Altera software Utility and the correct 
Orion_MkII_bootloader.pof will fully refresh the EPROM with both the critical first step bootloader and the FPGA 
operational .rbf file (as shown in the diagram above).

At this time (March 2017) a ByteBlaster is generally not needed. The new firmware and software that is 
distributed by the OpenHPSDR organization is robust and stable for the new ANAN-8000DLE. 
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ByteBlaster firmware cabling
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Appendix - LCD Display firmware update
The ANAN-8000DLe Transceiver includes a sophisticated microprocessor controlled LCD Display. The LCD 
Display *and* monitors various operational parameters such as SWR, FWD. REF, Vdc, Idc, Temperature, and 
Rx/Tx status as shown on page 16.

The Microprocessor is an Arduino Nano type device and it can be updated to the latest firmware by the Apache 
Repair Depot, or by a careful and detail conscious end-user. 

You should NOT attempt a firmware upgrade unless you have studied these instructions and feel confident that 
you can accomplish this, rarely required, task.

The author, John Melton GØORX/N6LYT has provided a detailed step-by-step instruction sheet 
located below:

Install Arduino IDE

https://www.arduino.cc

Click on Software
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Under Download the Arduino IDE

Click on version for your platform (Windwos, Mac, Linux)
Download and follow the install instructions.
You should now have a short cut to the Arduino IDE on your desktop.
Reboot windows to install drivers

Download sketch:

     Sketch Arduino IDE  
Extract the zip file

Open Sketch with Arduino IDE

Start Arduino IDE.
Open Sketch:
File → Open    and navigate to the directory created where the zip file was extracted and select
Select the  SSPA_V08_1.01 directory and then select the SSPA_V08_1.01 file and click on 
Open
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Add LCD display library:

Sketch → Include Library → Add .ZIP Library …
Navigate to the directory where the zip file was extracted and select the LiquidCrystal440 zip file and 
click on Open.

Note that this version has been modified to work with the latest IDE.

Setup board to compile for:
Tools → Board → Arduino Nano
Verify the sketch will compile:
Sketch  → Verify/Compile

Upload Sketch to 8000DLE

Remove power from the 8000DLE.

Remove the top cover of the 8000DLE by removeing the 3 screws from each side and the 2 screws from
the back.

Connect a USB Mini-B cable to the U12 socket on the back of the Display board and connect 
the other end to the computer. Note that the controller board will light up and become 
active using the power form the USB cable.

LCD Panel showing USB connector U12
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Start Arduino IDE

LCD Panel showing location of USB connector U12

Start the Arduino IDE and load the sketch (see above).

Select the port that the USB cable is connected to using Tools → Port on the Arduino IDE.

Upload the Sketch using Sketch → Upload on the Arduino IDE.

Once loaded the controller board will reset and restart using the new code.

Remove the USB cable.

Replace the cover.

Power on the 8000DLE.
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